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Introduction
Tap Forms is a very powerful organizational tool designed to help you keep track of all your life’s most
important information at home, at work, or on the go. With built-in support for iCloud, now you can keep all
your Tap Forms data on your iPhone and iPad in sync with your Mac. So when you’re out and about and you
need to lookup some important piece of information, you can be confident to know that you’ll have it right
there with you.

Forms, Fields and Records —>
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Forms, Fields and Records
A Tap Forms database contains Forms, Fields, and Records.

A Form is simply a template which contains a collection of fields that describe the data you wish to capture
and print.

A Record is an instance of a Form which contains the actual data values that you are recording.

Tap Forms contains 27 built-in forms ready for you to use and customize. You can even delete them if you
don’t wish to keep them in your database. You can also create new forms from scratch which you customize
to capture exactly the kinds of data you want to keep track of.

— Introduction Using the Built-in Forms —>
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Using the Built-in Forms

1. Click on the My Forms popup button and switch from the My Forms
item:

to the All Forms item:

You should now see a list of all the built-in forms that are available to you. You may need to expand the
categories to display the list of forms beneath each category heading. Note that if this is the first time you’re
using Tap Forms, most of your forms will have 0 records in them.
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2. Click on a form to select it.

There are currently no records in the selected form.

3. Click the + button next to the form name in the second column to add a
new record to your selected form.
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Fill in all the fields in your new record.

— Forms, Fields and Records Creating a New Form —>
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Creating a New Form

1. Click the + button at the top-left of the window.

A new form sheet will display where you can give your new form a name and select an icon as well as set
other properties of your form.

2. Click the Field Properties tab and add some fields by clicking the +
button below the fields list.

As you add new fields, Tap Forms will display the properties inspector for each field type you add on the
right. Here you can set different field properties such as the field name, field type, number formatter, decimal
places, default value, etc. Each field type has its own unique set of properties you can change. On this screen
you can also rearrange the order of fields by dragging them up and down. By rearranging the order of fields,
Tap Forms will display them in whatever order you’ve set on the Default Layout and on the Multi-column List
View. You can also delete fields by clicking the delete button next to the add field button. There is also a
duplicate field button which will duplicate the selected field.
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3. Click the Form Properties tab.

You can set a variety of form level properties such as the Category your form will be located in, what the First
Sort Field, Second Sort Field, Third Sort Field, and Group Records By fields will be. You can choose the sort
direction too by clicking on the up or down arrows next to the sort field popup buttons.

If you drag a Photo field to the first position in your form, Tap Forms will display the thumbnail
of the photo to the left of the next set of fields. You can control the size of the thumbnail on the
Photo properties view.
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Calculation

If you have any Number, Rating, Checkmark, or Calculation fields in your form, you can use the Calculation
Field and Calculation Type to tell Tap Forms to compute the total, minimum, maximum, or average of the field
that you selected. The results will be displayed at the bottom of the records list.

List View Fields is used to tell Tap Forms how many fields to display on the records list view. You can tell
Tap Forms to display the first 2, 3, 4, or 5 fields on the records list view.

4. Click the Done button when you’re finished customizing your form.

Tap Forms will now create an empty record for you which you can then fill in to add your information.
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Continue adding as many records as you like.

— Using the Built-in Forms Field Types —>
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Field Types

Tap Forms has 20 different field types. Each field type has its own set of properties that can be set in order
to customize the way Tap Forms displays and edits your data.

The following table describes all the field types available in Tap Forms.

Icon Field Type Description

Text Text fields store small amounts of text. Normally a single line’s worth. For example, a Movie
Title.

Number
Number fields display numeric data. They can be configured to format the display as
currency, decimals, percentages, scientific notation, spell out (e.g. “twenty four ninety
nine”), or as a duration (e.g. “10 hrs, 3 mins” or “10:03”).

Date
Date fields will display the month, day, and year. The display format used depends on your
Region Format settings in the System Preferences. In general, Tap Forms uses the Medium
date format to display dates.

Time
Time fields will display the hours and minutes and AM or PM. This also depends on your
region settings. If you have 24 hour mode enabled then you won’t see AM or PM. Tap
Forms uses the Short time format to display times.

Date &
Time

Date & Time fields are a combination of the Date and the Time fields displayed in a single
field. The Date part will use the Medium date format. The Time part will use the Short
format. By adding a Date & Time field to your form, you can also enable the Alerts function
in Tap Forms. With the Alert function you can tell Tap Forms to notify you at the specified
date and time. You can also include a short note which will be displayed along with the
notification. Alerts can be scheduled to repeat at a variety of frequencies. These options are
available when you’re editing a date value in your record.

Date
Created

Tap Forms keeps track of the date a record was created. The Date Created field type will
expose this field to your forms. You can sort by this field or filter your records by this field.

Date
Modified

Tap Forms also keeps track of the date and time a record was modified. You can sort by
this field or filter your records by this field. Please note however that if you change the
sorting of your form after your form is created, Tap Forms will update the Date Modified
value for each record to be the current date and time. So it’s best to set it once and leave it.

Audio
Recording

Tap Forms for Mac can play back audio recordings made on Tap Forms for iOS, but it
cannot record audio notes on its own. When you sync with iCloud, Tap Forms for Mac will
gain access to the audio notes you created on iOS.

Calculation

The Calculation field type lets you construct formulas to compute mathematical
expressions. Formulas can contain references to other fields within your form. You can use
all the basic mathematical operators such as ( ) * / – + as well as the keyword $now. The
$now keyword will insert the current time into the formula before being evaluated.
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Checkmark

The Checkmark field lets you have a basic on/off switch for setting whether something is
true or false, on or off, yes or no, etc. Checkmark fields can be used in formulas also. For
example, if you wanted the total to be computed only when a checkmark field is on, just
drag the checkmark field into your formula and use multiplication to cause the result to be
either 0 if it’s off or whatever the regular result would be if the checkmark field value is on.

Contact

The Contact field lets you reference a contact from your Mac’s Contacts database. Tap
Forms will copy the first and last names into its database as well as the Contact’s unique
identifier. This information will be used to look up the contact’s record from the Contacts
database whenever you click on the contact button to the right of the field. Note: due to the
way Apple syncs contacts across devices, the unique identifier could get changed between
devices. This can cause Tap Forms to display the wrong contact when you click on the
contact button to the right of the field.

Drawing The Drawing field type on Mac is a read-only field. You can create drawings on iOS and
view them on the Mac version. You cannot draw into a field on the Mac version.

Email

The Email field will give you a button to the right of the field which will launch Mail whenever
clicked and pass the email address entered into the field into the To: field of a new email
message. Separate email addresses with commas to address more than one email address
at a time.

File
Attachment

The File Attachment field will let you store one or more files associated with your record.
You can tell Tap Forms if your File Attachment field supports just one file or multiple files by
checking the Multi-File Enabled checkbox on the Field Properties screen. When Multi-File
Enabled is checked, you will see a list of files within your File Attachment field. You can
double-click on a file to launch the app which is responsible for that field type. You can also
choose to attach your file as a copy of the file or as an alias of the file. When you attach a
copy, Tap Forms will copy the file selected into its Attachments folder. The Attachments
folder is synchronized using iCloud to your other devices. So you will be able to access the
same files on your iOS devices and other Macs that are all using the same iCloud account.
Aliases cannot be viewed on other devices.

Link to
Form

This field lets you connect different forms together. Use One to Many if you don’t want or
need to share the records from the linked form with other forms or records. Use Many to
Many if you’d like to be able to select from a list of previously entered records from another
form and link them to the parent record.

Location

The Location field type will display to you a map of your current location. You can search for
different locations and drag the pin around to change your location. You can also edit the
location name, but Tap Forms will first do an address lookup to fill in the address that
matches your current location.

Note
The Note field type allows you to enter in large amounts of text. Text can also be styled
using different fonts, sizes, and colours. The Mac version has the ability to add bulleted
lists, but these are not displayed on the iOS version of Tap Forms.

Phone
The Phone field will convert a set of digits into a formatted phone number taking into
consideration different region formats for phone numbers. The iPhone version will also dial
or text the number when the phone button is tapped.

Photo The Photo field will let you select a photo from your hard drive or use the built-in camera to
take a photo. You can also drag and drop an image into the Photo field from your hard
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drive. Once a photo has been attached to your Photo field, you can click on the QuickLook
button to view a larger version of the photo or click the trash can button to delete it.

Rating

The Rating field will display up to 10 stars that you can click on in order to rate your records.
For example, if you were maintaining a movie library you could add the film’s popularity
rating to your record. Ratings can be used in calculations and also at the form level. So you
could display the average rating for all the movies in your library.

Section
Heading

The Section Heading field will help you to organize the fields within your form into sections.
This makes working with long forms much easier.

Website
The Website field lets you store an address to a website or even another application on
your own computer. When you click on the website button to the right of the field, Tap
Forms will launch your web browser and take you to the address specified.

— Creating a New Form Searching —>
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Searching

Tap Forms can perform two kinds of searches.

1. Search across all text and number fields in a form by using a simple search term.
2. Create one or more search rules which target specific fields for searching.

For basic searches, just enter a search term into the Search field:

After you type in a search term, a bar will appear below the Search field with a Save button.

Click the Save button to save the search. Tap Forms will display the search beneath the form on the left side
of the window.

For more advanced searches, click the Search button to the left of the Search field. Tap Forms will display
the advanced search popover where you can add Search Rules which target your search to specific fields.
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Click the + button to the right of a Search Rule to add a new Search Rule.

Click the Save button to save your search. Click the Search button if you don’t want to save your search but
you still want to filter your records.

— Field Types Categories —>

When you add multiple Search Rules, Tap Forms will combine each rule together to reduce
the number of records returned from the search. So the more Search Rules you add, the fewer
records will be returned.
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Categories
Categories are used to group forms together. Tap Forms ships with a few built-in categories, but you are free
to modify them, delete them, or add to them.

To manage your categories, click on the Categories button in the tool bar.

You can drag the categories up and down to rearrange them. The list of forms on the left will update when
you rearrange your categories.

If your categories are not showing any forms beneath them then it’s probably because they are in a collapsed
state. Hover your mouse over the categories to reveal the Show button on the right. Click on it to expand the
category.

If you delete a category, all forms which belong to that category are moved into the
Uncategorized category. You cannot delete the Uncategorized category.
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— Searching Pick Lists —>

Tap Zapp Software Inc. Tap Forms Mac - 2.0

Generated by Manula.com on May 14, 2014 15:34:34 Page 16 of 50



Pick Lists
Pick Lists are convenient lists of values that you can use on any Text or Number field in any form. You can
even share the same Pick Lists between different forms and fields. You can create single select pick lists
or multi-select pick lists. They both show the same information but multi-select pick lists allow you to select
more than one value at a time. Single select pick lists allow you to select only a single value at a time.

To edit a Pick List, click on the Pick Lists button in the toolbar:

To add a new Pick List, click the + button at the bottom-left of the popover. Click the checkbox in the multi-
select column to make the new Pick List a multi-select Pick List.

To add a new value to the selected Pick List, click the + button beneath the values list.

If you have lots of values to add to a Pick List, it would be much quicker to click the Add Values… button and
type your new values into the popover that is displayed. You can even paste values into the popover if you
already have a list of values on your clipboard.
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To associate a Pick List with a field:
1. Click the Edit button for the form.
2. Click the Field Properties tab.
3. Click the field that you’d like to associate the Pick List with.
4. Click the Pick List popup button.
5. Select the Pick List from the popup button.
6. Click the Done button on the Edit Form sheet.

— Categories Layout Designer —>
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Layout Designer
The new layout designer makes creating beautiful layouts as easy as dragging and dropping.

To create your first layout, click the + button beside Default Layout

Click the Edit Layout button to display the Layout Inspector panel:
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The Layout Inspector provides you with tools to customize the layout of your form’s fields and other graphic
elements you might like to have on the page.

The first row of buttons in the Layout Inspector let you turn on and off the Layout Inspector itself, the Text
Inspector, the Rulers, and the Snap to Grid functionality.

The second row of buttons contains the layout designer tools.

The Arrow tool lets you select, resize, and drag around the objects on your layout page.

The Line, Oval, and Rectangle tools allow you to draw lines, ovals and rectangles on the page. You can
constrain the line, oval or rectangle by holding down the shift key as you drag a handle around on the page.
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You can change the stroke of a line, circle or rectangle to make it thicker or thinner. You can also change the
stroke colour of lines, ovals, and rectangles using the Graphic Properties Inspector which will appear when
you select an object. Ovals and rectangles can also have their fill colours changed.

The Text tool allows you to create blocks of text which will stay the same on every record. This would be
useful for things like company names, addresses, or any other kind of text that you want to remain the same
on every record.

The Image tool allows you to create areas on the layout which will be filled with any image you have available
on your computer. These images will stay the same on every record. This would be good for things like a
company logo, icon, photo or any other kind of image you want to have on every record.

Layout Properties

The Layout Properites panel lets you change the layout name, what your’e designing your layout for (screen
or printer), set the printer, the page size, and the page orientation.

Fields and Layers

The Fields list shows all the fields that are available to be dragged into the layout area. Below the Fields list
is a checkbox which will tell Tap Forms to automatically create a label for you when you drag a field to the
layout area. Labels will be given the default value of the field name, but they can be changed after they have
been created. You can change label colours, fonts, sizes, and text alignment.

The Layers list shows all of the objects that are already on the page. You can drag these objects up and down
to send them behind or in front of other objects. You can also lock objects so they can’t be moved around
accidentally.

Text Inspector and Alignment Controls

The Text Inspector lets you set fonts, sizes, colours and text alignment (left, centre, right, or full). When the
Text Inspector is visible you also have access to controls for aligning objects on the layout area. You can
select multiple objects and align them all together using these controls.

The Image tool is different than a Photo field in your form. A Photo field will change its image
with every record while the Image tool’s image will remain the same on every record.
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Objects can have their left edges, right edges, bottom edges, and top edges aligned. They can also be
aligned vertically or horizontally. The Layout menu also gives you some further options for sizing all the
selected objects so they become the same width or height.

The Text Inspector can also be used when editing a record to set the text properties of a Note field. You can
highlight some text and change the font, the font size, make it bold, italicized, underlined, or adjust the text’s
alignment.

— Pick Lists Bento Template Importer —>
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Bento Template Importer
Tap Forms for Mac 2.0 includes a new Bento Template Import command to help you in making the transition
from Bento, which has been discontinued by FileMaker, to Tap Forms.

To import your Bento template in Tap Forms:
1. Launch Bento and select your library.

2. Select Export… from the File menu and choose the Template option.

Tap Forms will import Bento 3.0 to 4.1 version templates. You will need version 4.0 or higher of
Bento in order to be able to export your Bento data along with your templates. Please download
the Bento 4.1.2 update from here: http://help.filemaker.com/app/answers/detail/a_id/11182
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Make sure you click on each related library displayed in the “Include these related libraries” list if you want
Tap Forms to be able to join your related forms together. Also click on “Include records in template” if you
want Tap Forms be able to import your Bento data also.

3. Save your template.

If you don’t see the “Include records in template” option, then you’re not using the latest version
of Bento. You’ll need to download that first before proceeding. The link is at the top of this page.
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4. Launch Tap Forms and select the “Import Bento Template” command
from the File menu and select your Bento template file.

Click the Choose button when you’ve found your Bento template.

Tap Forms will now import your template and records.

If your template contains more than one related form, Tap Forms will automatically create a new category for
you and put your related forms together inside that category. The category will be given a name based upon
the file name of the template you are importing.

You will need to expand the category to view the forms by clicking just to the right of the category name on
the “Show” text.
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— Layout Designer Bento Fields in Tap Forms —>

Once you’ve imported your Bento template, you can click on any of the layouts that Tap Forms
generated from the Bento library. You may need to reposition some elements and/or make some
adjustments to the font sizes and styles.

Tap Zapp Software Inc. Tap Forms Mac - 2.0

Generated by Manula.com on May 14, 2014 15:34:34 Page 26 of 50



Bento Fields in Tap Forms

The following table describes how Tap Forms imports Bento forms and fields:

Bento Tap Forms

Form A Bento form is converted to a Tap Forms layout. Once you’ve imported a Bento template, you
can further customize the layout in Tap Forms or add additional layouts to meet your needs.

Text

Bento text fields can be one or more lines long. Tap Forms has 2 different text field types.
• Text fields are used for shorter one-line bits of information, such as a Movie Title.
• Note fields are used for larger amounts of text, such as a Movie Synopsis.
• Tap Forms will convert Bento text fields into Text or Note fields depending on the height

of the field in the Bento form.
• Tall fields in Bento will be converted to Note fields in Tap Forms.
• Small fields in Bento will be converted to Text fields in Tap Forms.

Number Bento Number fields are converted to Number fields in Tap Forms. The Number Formatter is set
to Decimals.

Currency

Bento Currency fields are converted to Number fields in Tap Forms. The Number Formatter is set
to Currency and the Decimal Places is set to 2. Note: Tap Forms supports only the currency that
you have by default according to the system’s regional settings. For example, in Canada, all
currency values will be in CAD. In the UK, all currency values will be in GBP.

Counter Counter fields are converted to Number fields.

Duration Duration fields are converted to Number fields with the Number Formatter set to “hours, mins”.

Rating Rating fields are converted to Tap Forms Rating fields.

Dates and
Times

Times are converted to Time fields. Dates are converted to Date fields. If the Date field has the
flag to show the Time set, then it’s converted to a Tap Forms Date & Time field.

Media Media fields are converted to Photo fields. The photo file is also extracted and copied into the Tap
Forms Photos folder.

Checkbox Checkbox fields are converted to Checkmark fields.

Choice Choice fields are converted to Text fields. The values in the Choice field are converted to a Pick
List and associated with the Text field.

Calculation

Calculation fields are converted to Calculation fields. Tap Forms makes a best guess at trying to
convert the Bento formula to a Tap Forms formula, but it’s not going to be very accurate since
Bento supports more calculation options than Tap Forms at this time. You will probably have to re-
do your calculation formulas after the migration.

Location Locations fields are converted to Location fields. The longitude and latitude values are also set as
the location name in Tap Forms.
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Phone Phone number lists are converted to a Phone field in Tap Forms. Only the first phone number is
imported. All other phone numbers in the list are ignored.

Email Email lists are converted to an Email field in Tap Forms. Only the first email address is imported.
All other email addresses in the list are ignored.

URL URL fields are converted to a Website field. Only the first value is imported. All other URL values
are ignored.

Related
Records

Related Record fields are converted into Link to Form fields with the Many to Many Link Type set.
Tap Forms also re-establishes the relationship data between forms.

File List File List fields are converted to File Attachment fields with the Multi-File Enabled setting turned on.
Files are copied into the Tap Forms Attachments folder.

The Bento Template Importer will be improved over time as new features are added to Tap Forms which
match some of the features previously available in Bento.

— Bento Template Importer Import Records —>
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Import Records
Tap Forms provides a wide variety of options for importing data from other applications. Before you can
import a file to Tap Forms you must export it from another app to a text file. The text file can have a .csv
(comma separated values), .txt (text), or .tsv (tab separated values) file extension. These file types are
all pretty much the same but contain slightly different column delimiters. Just make sure whatever column
delimiter you use in the file, you set Tap Forms to use the same column delimiter.

Choose File
The first thing to do is click the Choose file button and then select a file you wish to import.

When you import a CSV file, Tap Forms uses the first row of your file as the field names to
create when you choose the New Form option. If you choose an existing form to import your
records into, you must make sure that the first row values match the field names exactly as you
have them named in your form. Otherwise Tap Forms will create a new field for every value in
the first row which does not match a field name in the form you’re importing into.
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File Encoding
It’s very important to set the file encoding setting correct for the file you’re trying to import. If you don’t set it
correctly, Tap Forms won’t be able to understand all the characters in the file you’re trying to import. This will
most likely manifest itself in Tap Forms importing fewer rows than are actually in the file. Another issue that
you might notice is strange garbage characters appearing instead of properly accented characters.
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Column Delimter
Tap Forms supports the following set of column delimiters: comma, semi-
colon, tab, and pipe. Column delimiters help tell Tap Forms how to
distinguish one field’s value from the next. If you have a delimiter within
your data then you must put double-quotes around the value. For example
“Rolling Stones, The”. Because there is a comma in the value, the entire
value must be surrounded with double quotes. Mostly you never have to

worry about this sort of thing because programs like Excel and Numbers should automatically put double
quotes around any data that contains a column delimiter within it. Tap Forms does then automatically when
you export records.

Date Format
When you have a file that has dates in it, Tap Forms needs to be
told how to interpret the date values. Is it month, day, year, or day,
month, year? In order for Tap Forms to understand the date values
in your file, you must tell it what format your date columns use. Tap
Forms only understands date formats that are numeric based. So if
you have a date in your file like “Dec 10, 2013” then you need to
convert that to be “12/10/2013” or some other variation on a
numeric date format. As long as it follows one of the formats
displayed in the list of date formats in Tap Forms.

There are a couple Date & Time formats in the popup menu also. You can use these if your date has a
combined date & time value within it that has the date and time separated by the letter T. For example, when
Bento exports its Date & Time values it uses this format: yyyy-MM-dd’T‘HH:mm:ss

File encoding is just a way of describing to a computer which characters the data in the file
represents. When you open a text file we just see characters, words and sentences. But to a
computer, the file contains just a bunch of numbers all strung together. File encodings tell a
computer what characters to display on screen when it encounters different numbers in a text
file. For example, the character A is number 65, B is 66, and so on when using the ASCII
file encoding format. UTF-8 is the most sensible file encoding to use because it can encode
characters from any language on Earth. However, if you’re importing from a Windows PC that
exported a CSV file using Excel, you most likely want to use Windows Latin 1. On the Mac you
may need to use Mac OS Roman file encoding.
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Time Format
Time formats follow the same principal as date formats. Just make sure
your time format is set to be the same format as what is contained within
your CSV file.

Select a Form
You can either enter a name for a new form to be created, or if you already have a form that you’d like to
import your CSV file into, select it from the list of available forms. If you select New Form, Tap Forms will
create a new form for you using the field names from the first row of the CSV file.

Assign Field Types

It’s important to tell Tap Forms before you import a CSV file what the field types are that it is importing. This
helps Tap Forms to properly interpret the data being imported. If you don’t do this and you try to change field
types after then Tap Forms will appear to lose the values in the field for which you changed the type. The
data is not gone, it’s just stored in a different column in the database.

Record Navigator
Click the record navigator to flip through the records in your CSV file. This will help
you to determine if you have your file encoding, column delimiter, and your date

and time formats set correctly.

Click the Import button when you’re ready to start the import process.

— Bento Fields in Tap Forms Export Records —>

Tap Forms stores text data in a different column than it stores dates, numbers, location,
or checkmark data. There are some fields which you can safely switch types. For example,
switching a Text field to a Note field is safe. Switching a Rating field to a Number field is safe.
But switching a Text field to a Date field is not safe.
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Export Records
Along with importing CSV files, Tap Forms can generate CSV files so you can use your Tap Forms data in
other applications.

To export your records, click the File menu and select Export Records…

The various options on the Export Records screen tell Tap Forms how to generate the file that you’ll import
into other applications.

File Encodings

As in the Import Records function, you can tell Tap Forms to export your file in a
variety of file encodings. UTF-8 is generally the best encoding to use as it supports
encoding characters in all languages. It may depend on the program you want to
import your data into that dictates which file encoding you should use. Check the
other program to see what file encodings it supports.

Number Formats
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Tap Forms can also export Number fields in a variety of different formats. For the
Currency format, Tap Forms will use your regional number format settings to
determine what currency symbol to use during the export. For example, in Canada
and the USA currency numbers will be exported like $29.99, but in Europe the
same value would be exported as 29.99 €.

Export Record ID

By enabling this option, you’re telling Tap Forms to export the values that uniquely identify each record in
your form. Tap Forms will add a column called form_record_id to your CSV file. If you import a file into Tap
Forms which has a form_record_id column, it will search for matching records and update their field values
rather than adding new records to your form.

Export Linked Records

With this option enabled, Tap Forms will generate separate files containing the records from any linked forms.
If you want to import these files into another copy of Tap Forms, make sure you import the parent form’s CSV
file first and then import the child records. That way Tap Forms will be able to join up all the child records to
the parent records.

Field Type Tags

By turning on Field Type Tags, you’re telling Tap Forms to generate a header row that contains a tag that
identifies the field’s type.

The following are the tags that Tap Forms will generate

Tag Field Type

<text> Text

<number> Number

<date> Date

<time> Time

<date_time> Date & Time

<check_mark> Checkmark

<contact> Contact

<web_site> Website

<note> Note
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<photo> Photo

<audio> Audio Recording

<phone> Phone Number

<rating> Rating

<location> Location

<email> Email Address

<calc> Calculation

<file> File Attachment

<form> Link to Form

<draw> Drawing

<section> Section Heading

<date_created> Date Created

<date_modified> Date Modified

For example, a CSV export file of a movie library form would look something like this:

Movie
Title<text> , Release

Year<number> , Synopsis<note> , I Watched
This<check_mark>

Terminator
2:
Judgement
Day

, 1991 ,

The cyborg who once tried to kill Sarah Connor is
dead, and another T-101 must now protect her
teenage son, John Connor, from an even more
powerful and advanced Terminator, the T-1000.

, 1

Export Media

When you enable this flag, Tap Forms will generate a zip file that contains your records in CSV files and also
a folder within the zip file that contain all of the media referenced in your records. Each media type will have a
separate folder named with the name of the form being exported and the media type. For example “My Work
Expenses-Photos”, “My Work Expenses-Files”, etc.

— Import Records Backup & Restore —>

At the moment, file attachment fields with the multiple files setting enabled won’t get exported
into the zip file. That feature is coming in a future update.
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Backup & Restore
From the File menu, select Backup… to have Tap Forms generate a backup file for you.

Backups have file names that start with TF and end with .zip. The file name also contain the name of your
computer and the timestamp of when you selected the Backup command. Backup files are just compressed
files that contain your database file, photos, drawings, audio recordings, and file attachments. So you can
double-click on one to uncompress it to see what’s inside.

Choose the Restore command to select a backup file and restore it over top your current database.

— Export Records iCloud Sync —>

Restoring will erase all the data in your current database and replace it with the data from the
database file contained within the backup file.
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iCloud Sync
Tap Forms uses iCloud to sync data between your devices. Specifically Tap Forms uses the Documents
& Data iCloud service. So before you can enable iCloud sync in Tap Forms, please make sure you have
Documents & Data enabled in the iCloud settings on all your devices.

Enable iCloud Sync in Tap Forms on all your devices.
1. Click the iCloud button in the toolbar
2. Click on the Enable iCloud Sync checkbox.
3. Do the same on your other devices.
4. You will see each registered device listed underneath the Registered Devices list. You may need to

close the iCloud Sync popover and reopen it for the list to refresh on the Mac version.

In the most recent version of Tap Forms for Mac and iOS, you will now need to visit the Security
Settings screen and set the encryption key to the same value on all of your copies of Tap Forms.
If you don’t do that you may encounter a Sync Failed message.

If you don’t see all the devices you’ve enabled iCloud Sync on in Tap Forms on the list of
Registered Devices, then reboot all your devices. On iOS do a complete power off and then
power on. Then check the list again.
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Whenever you want to send the changes you’ve made on your Mac to your other devices, click the upload to
iCloud button at the bottom-right of the window or click the Sync Now button in the iCloud Sync popover view.
Uploading to iCloud is a manual process. The upload to iCloud button is used ONLY for uploading your
data to iCloud. Downloading from iCloud is an automatic process. You don’t need to do anything to trigger a
download from iCloud.

iCloud Sync in Action

Watch this Youtube video to see how iCloud sync is used in Tap Forms.

— Backup & Restore Relationships —>

When you register a device with iCloud, your files will be moved from your device into your
iCloud storage space. Depending on the size of your files (Photos, audio recordings, files in the
Files area, etc.) and the number of them, it may take quite a while for them to be uploaded to
iCloud and synced to your other devices. During this time, the iCloud Sync screen may take
considerable time to return the list of registered devices to you. Please be patient and wait a
while before trying again. You can continue to use Tap Forms while this happens automatically
in the background.
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Relationships
Tap Forms has the ability to link forms together to establish relationships between them. There are currently
two types of links:

1. One to Many
2. Many to Many

To make it easier to identify what is being talked about in this section of the documentation, I’ll refer to the
main form as the parent form. Any form that the main form links to will be called the child form.

One to Many

The One to Many link type is useful in situations where the child form’s data is unique to the parent record it’s
linked to. That is, no two parent records should link to the exact same records from the child form. It’s easiest
to describe this situation using an example.

Keeping Track of Clients and Expenses

If you wanted to keep track of all the expenses you incur when working for a specific client, you wouldn’t want
those expenses to be linked to any other client than the one for whom you are currently working. A one to
many relationship is useful in this situation. One client has many unique expenses which are attributable only
to it.

Create a Client Expenses form:
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Create a Clients form and link it to the above Client Expenses form:
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Make sure you’ve selected One to Many as the Link Type.

Now when you add or edit a record on your Client form, you can see the list of Client Expenses. Initially there
will be none, but you can click the + button below the list of Client Expense records to add one. By adding a
record from this view Tap Forms will link the new Client Expense record to the parent Client record.
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When you add a child record to the parent record form, Tap Forms will switch the display to the child form (in
this case Client Expenses) along with a back button which when clicked will return you to the parent record
from where you came.

Many to Many

An example of a Many to Many link could be a list of team members who are assigned to projects for the
selected Client.

Add a Team Members form that contains a list of people that work at your company. You
could add their name and job title.
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Now add the linked form field to the original Clients form:
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Make sure you click on Many to Many for the Link Type and select the Team Members form from the Link to
Form property.

Now when you view your Client record the list of Team Members will initially be empty:
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After you’ve added some Team Members you’ll be able to select from the list of Team
Members by clicking on the checkmark button just below the linked field.

This will display a popover with a list of child records which haven’t yet been linked to your parent record.
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Select one or more records from the popover and then click the Select (#) button.
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The list of linked records will update to show the records you’ve previously selected and the records you’ve
just selected.

And that’s the difference between a One to Many and a Many to Many Link to Form field.
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Menu Commands
Tap Forms gives you the ability to perform a variety of commands on forms, records, and layouts. For
example, you can delete a form, duplicate a form, share a form template with others, and import a form
template you’ve been given by others. You can create new records, delete records, duplicate records.

File
The File menu contains a variety of commands for exchanging your data with
others. It contains commands for importing records, exporting records, importing
form templates, exporting form templates, importing Bento templates, backing up
your database, restoring your database and printing your forms. Other topics in this
guide will go through each of these options in detail.

View
The View menu lets you switch between different views. You can switch
between the All Forms and My Forms lists of forms and between the Single-
Column and Multi-Column records list views.

Forms
To delete a form, select a form and click the Forms menu. Then select the
Delete Form command.
When you delete a form, Tap Forms will delete all of the records and all of the
photos and files associated with the records in the form.

To duplicate a form, select a form and click the Forms menu. Then select the
Duplicate Form command.
When you duplicate a form, Tap Forms duplicates just the form template, not any of
the records.

You can also access these commands by right-clicking on the selected form in the My Forms or All Forms
list.

Records
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To delete a record, select a record and click the Records menu. Then select
the Delete Record command.
When you delete a record, Tap Forms will delete all of the photos and files
associated with the selected record.

To duplicate a record, select a record and click the Records menu. Then
select the Duplicate Record command.
When you duplicate a record, Tap Forms will duplicate all of the photos, drawings,
and audio recordings associated with the record. File Attachments will not be
duplicated at this time.

You can also access the Duplicate and Delete commands by right-clicking on the selected record.

Go To
You can use the keyboard to quickly navigate between records. Command-]
will move to the next record. Command-[ will move to the previous record.
Command-shift-[ will move to the first record. And command-shift-] will move to the
last record in your form.

Layout
The layout menu provides a variety of commands for managing your custom
layouts. From here you can edit layouts, duplicate layouts, delete layouts and
perform a variety of commands on items in your custom layouts.

Tools
The tools menu just gives you an alternate way of
gaining access to the Pick Lists popover, the
Categories popover, and the iCloud Sync popover.
You can also access the Switch Languages function
here.

Switch Language
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Tap Forms supports a variety of languages. By selecting a language here, Tap
Forms will translate the built-in forms and fields into the language selected.
Regular user interface items such as menus, buttons and other text in Tap Forms
will display automatically based upon your computer’s language setting. Tap Forms
only supports the languages listed here.

— Relationships
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